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Section 1 — Introduction

This document provides Grantee Organizations (applicants) with details on the
Grants.gov security model and instructions on how to create digital certificates
complying with the Grants.gov mutual authentication requirements.

Section 2 — Applicant System to Grants.gov
Authentication

Grants.gov uses SSL with mutual authentication to establish a secure connection with
applicant systems. (For more detailed information on SSL please refer to Appendix 1.)
To do so, applicant systems are required to obtain and install a digital certificate on their
application server. This certificate will be used to authenticate the applicant server when
sending requests to Grants.gov over SSL.

Once the authentication step is completed and a secure connection is established, the
Grants.gov system conducts an internal authorization process to ensure that the
requesting applicant server has been assigned the appropriate roles before performing the
requested transaction. After the certificate has been registered with Grants.gov, the
applicant is ready to establish a secure layer between an applicant system and Grants.gov:

e The applicant sends a request via an https:// call to a Grants.gov web server that
has registered the public certificate. The acceptance testing environment address
is https://atws.grants.gov:446 and the production site is https://ws.grants.gov:446.
Note: the server conducting the Web Service calls must have access to port 446.

e Next, Grants.gov validates the applicant certificate’s serial number against the
information in the certificate’s profile. It also checks the valid period and the CA
of the certificate. If validation fails, the SSL will not be established. If
validation succeeds, the following steps occur.

o Grants.gov web server presents the applicant system with its public key
certificate.

o If the applicant system accepts the certificate, it uses the public key to
encrypt the data it is about to send.

o Grants.gov using its own certificate private key decrypts the sent
encrypted data and a secure connection is established. The subsequent
request/response message exchanges occur over the secure socket.

Once authentication is completed and a secure connection established, the Grants.gov
system conducts an internal authorization process to ensure the requesting applicant
server has been assigned AOR privileges before performing the requested transaction.
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Section 3 — Client Certificate Requirements for Mutual

Authentication

Each applicant system shall provide a digital certificate to interact with Grants.gov. In
addition, Grants.gov requires mutual authentication to complete the SSL handshake.
Mutual authentication will require the client application to authenticate itself by sending
its server certificate. Grants.gov only supports certificates generated using the RSA
algorithm and signed by a recognized CA.

Grants.gov recommends that developers test mutual authentication with the
reference implementation server application. Testing with the reference
implementation allows developers to minimize the time required to flush out
potential SSL handshake issues within client applications. To test mutual
authentication with the reference implementation it will be necessary to set the HTTPS
connector’s “Client Authentication” property to “True” in the Tomcat administration
tool. Please refer to the reference implementation instructions for more information on

the Tomcat setup.

Note: Tomcat and Sun’s default JCE provider for JSSE does not support 1024 bit RSA.
Ensure when creating an RSA keypair to use 2048 bit key sizes (or see Configuring

Bouncy Castle for JSSE).
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3.1 Client Certificate Requirements for Acceptance Testing

e The applicant system shall provide Grants.gov a copy of their public certificate.

e C(Certificates shall be created using 1024 or 2048 bit RSA.

¢ The certificate must be signed by a recognized CA (see_5.0 Obtaining a CA
Signed Certificate).

3.2 Client Certificates Requirements for Production

e C(Certificates shall be created using 1024 or 2048 bit RSA.
® A well-know public CA must sign the client certificate for production usage.
Listed below are several popular CAs:

o Access Certificates For Electronic Services (ACES) -

http://www .trustdst.com/federal/aces.html

o Entrust - http://www.entrust.com

o Thawte - http://www.thawte.com

o VeriSign - http://www.verisign.com
Self-signed certificates will not be allowed.

3.2.1 Configuring Bouncy Castle for JSSE.

The Sun default JCE provider packaged with J2SE 1.4 currently does not support 1024
bit RSA certificates. Applicant systems using JSSE with 1024-bit RSA must, therefore,
use an alternate JCE provider to enable mutual authentication with Grants.gov. One
option that has been used with success by other testers is Bouncy Castle
(http://www.bouncycastle.org/). Bouncy Castle provides a free implementation of the
JCE framework that is compatible with many versions of the J2SE. Applicants may also
use other providers capable of providing the same functionality.

Installation and configuration of Bouncy Castle is very simple. For detailed instructions
see the following URL (http://www.bouncycastle.org/specifications.html).

3.3 Generating RSA KeyPairs and Certificates

There are many tools available for applicants to generate the required RSA keypair
including Microsoft IIS, OpenSSL, Keytool, and many others.

Grants.gov provides reference instructions for Portecle to generate the applicant system’s
RSA keypair and client certificate.

Portecle (formerly know as KeyTool GUI) is an open source GUI for the java keytool. It
can be downloaded at: http://sourceforge.net/projects/portecle/

The Java 2 Standard development kit is also required and may be downloaded at:
http://java.sun.com/
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3.3.1 Using Portecle to Generate a RSA Keypair

Portecle is a GUI version of the command-line keytool provided with the JAVA SDK.
Portecle can be downloaded at the following URL:
http://sourceforge.net/projects/portecle

Follow the instructions below to generate a Keystore, RSA keypair, and a digital
certificate. Upon completion the instructions below, applicant systems can expect to a
have fully compliant digital certificate for Grants.gov Web Services.

Open Portecle and follow the steps below:

1. Create a new keystore. Select File>New KeyStore.

=T
Eile | Tools Examine Help

[ Mew KeyStare U = = < TR S

=4 Open KeyStore Crl- 0 -

Save KeyStore Ctrl-= I Cestmpdined

B Save KeyStare As

=& 1 cacerts jks

=3 2 wehlogicTrustcacerts.jks
& 3 Testjks

=3 4 Test

@ Exit

|Create a new KeyStare

2. Select the JKS Format (for Java implementations) and click OK.

New KeyStore Type x|

Select the type of the new KeyStare:
W JKS

1 JCEKS

I PKCE#12

) BKS

) UBER

(0] 34 Cancel
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3. Select Tools>Generate KeyPair

£ KeyTool GUI 1.7 - [Untitled]

=10l x|

File Examine Help
G h W2 @

El Impart Trusted Certificate i T
u L& Import Key Pair Ctrl-K | Last mogified
42 Set KeyStore Passward  CiilP
3) Change KeyStore Type k
B keyStare Repart CHrkR
8- Options

|Generate a key Pair with selt-signed cedificate in the loaded KeyStore

4. Select 2048 bit RSA and click OK.

Generate Key Pair x|

Key Algotithim: () DSA (@) RSA

key Size: (2048

]34 Cancel
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5. The RSA keypair will be generated.

Generating Key Pair x|

Generating key Pair - this may take some time...

&Y

Cancel

6. Select a Signature Algorithm and enter the information specific to the organization.
Notes: Microsoft .NET users should select MD5 with RSA.
The Common Name must be set to the server’s DNS name.

Generate Certificate x|

Signature Algarithm: | MD2withRSA ™

Yalidity (days): (994

Camman Mame (SR |I|:u:alh|:|5t |

Qrganisation Unit QLY |I|:n:alh|:|st |

Qrganisation Mame {07 |YOUR QORG |

Locality Mame (L) |‘r‘OUR CITY |

State Mame (ST): [YOUR STATE |

Countey () (LIS

Email (E): [YOUR EMAIL |

Ok Cancel

7. Enter the alias.

Key Pair Entry Alias x|

Enter Alias: |i|:u:alhl:|st |

]34 Cancel
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8. Create a password and click OK.

9. Export a client certificate for Grants.gov. Right click the keypair generated in step 8

and select Export.

k| KeyTool GUI 1.7 - [Untitled]

File Tools Examine

Help

=10l x|

o @& 8 &8P HFH WK D

| Alias Name

| Last Modified

1Zeer

1=, +

&% loc

E& Cedificate Details

ra

(=]

Eﬁ.generate CSR
£ |mport CA Reply

Il Delete
[y Clone
Rename

%2 Set Password

Feb 27, 2004 11:37:39 PM EST

Exportthe Key Fair entry

V.
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10. Export the Head Certificate and Select the PEM Encoded Export Format.

Export KeyStore Entry ‘loc x|

~Export Type

i Head Cerificate
(1 Cerificate Shain
1 Private key and Certificates

~Export Format
' DER Encoded
® PEM Encoded
) PKCS #7

(O PKCS #12

] Cancel

11. Save and name the client certificate.

x
Look In: | (] Desktop - @ E

D atws.cer

|j| cecild! Zeertfromverisign.cer
[ HRsA cer

D localhost.cer

D Test.cer

|j| Test?.cer

File Marme: localhostoer

Files of Type: | X509 Certificate Files (*.cer®.crf) bt

Export Cancel

At this point, the client application will need access to the keystore generated from above.
The public certificate created above should be sent to Grants.gov WebServices team.
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The WebServices team will add the certificate to the Grants.gov truststore, register its
serial number and associate it with the applicant system’s profile.

3.3.2 Configuring Mutual Authentication for the Microsoft .NET
Platform

1. Follow the instructions for creating a Key Pair from above and be sure to select MD5
with SHA as the signature algorithm.

2. Once the certificate has been created, right click on the public private key pair and
select export.

k TKE‘rTunI GUI - [C:Documents and Settings' hustebrDesktop', skigs - |EI|£|
File Tools Help
0 = A8 S 8 PH @
7| alias | Last Mouified
E stigand: hdar 9, 2004 9:51:92 AR
Certificate Details
Generate CSR
Impaort CA Reply
Set Password
Delete
Clone
Rename
Exzport the Key Pair entry
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3. Export the Private Key and Certificates using PKCS #12 format

Export KeyStore Entry “ski 5[

Export Type

_J Head Certificate

i Certificate Chain

@) Private Key and Certificates

Export Format

) DER Encoded

i1 Base 64 Encoded
) PKCS #7

® PKCS #12

OK Cancel

4. Enter a new password for the PKCS #12 keystore

PKCS #12 KeyStore Password x|

Enter Hew Passwaord: |1"""“”’“'”Ht |

Confirm New Passworid: |*‘“‘m‘“’ |

OK Cancel
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5. Save the newly created PKCS #12 keystore with a .pfx extension to the local drive.

x|
Look In: ] Desktop | & @ @ @E

CJtemp

File Name: |Incalhust.pﬁd

Files of Type: |PKCS #12 KeyStore Files (*.pfx;*.p12) -

Export Cancel

6. Double click on the .pfx file that was just created, this will open up and pop up which
will walk you through the installation process for the certificate.

Once the certificate has been installed, click on START and then RUN and then type
MMC

8. When the MMC opens, click on the CONSOLE menu and then click on the
Add/remove Snap In.

9. Click Add and then Choose Certificates.
10. Click Add and then Choose Computer Account and then local computer

11. Once you see the certificates under the MMC, open up the certificates and here you
will see the various certificates that are installed.

12. Right click on the certificate that has to be exported and go to all tasks and then
export.

13. Select no when prompted if the private keys should be exported

14. Next select BASE64 encoded, as opposed to DER encoded, as the export format of
the public certificate.
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15. Save this to a file with a .CER extension and forward to the Grants.gov Web Services
team.

Section 4 — Obtaining a CA Signed Certificate

To receive a certificate digitally signed by a CA, you must send a Certificate Signing
Request (CSR) to the CA. A CSR is a text file containing information about the
requester’s server’s client public certificate. The CA will use the CSR to generate and
send you your signed digital certificate.

4.1 Using Portecle to Generate a Certificate Signing Request
(CSR)

1. Start Portecle and open up the keystore created in the Using Portecle to Generate
a RSA Keypair section.

2. Right click the mouse on the key pair and select Generate CSR

_{ol x|

File Tools Examine Help

s B8 8 89 F HK & @

| Last Modified

...... Feh 5, 20§

F& Certificate Details
ik Expart

gjll Generate CSR

2. Tmpork CA Reply
€22 Sek Password
M Delete

[ Clone

Renanme

IGenerate g Cerificate Signing Reguest (TSR] for the Key Pair entry

3. Save the generated CSR file with a .csr extension and submit it to your selected
CA.
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4.2 Importing the CA Reply

1. Once you have received your signed digital certificate from the CA, you must
import the certificate into your keystore. To do this, use Portecle to open your
original keystore that was used to generate the CSR.

2. Right click on the key pair and select Import CA Reply.

=10l x|

File Tools Examine Help

s B8 8 89 F HK & @

| Last Modified

eb2 Zond 2 oo P EST
@ Certificate Details

@ Export
Eﬂ_ Generate CSHE

23 Import CA Reply

&2 Set Password
i Delete

¥ Clone
Rename

Impiart & Cedificate Autharity (CA) reply into the Key Pair entry

)

(- Page 15 of 18
>~ GRANTS.GOV*®



3. Select the signed certificate you received from your CA, click OK, and save the

changes to the keystore. Your public/private key pair has now been digitally
signed by the CA.

Note: You may need to set the location of the Java cacerts file that contains the root
certificates of most signing authorities. Portecle uses these certificates to verify your
signed certificate. This setting can be found under Tools > Options.

=10 x|

File | Tools Examine Help

L gﬁ Generate Key Pair Ctrl+i3 @ E& | AT
E, Import Trusked Certificate  Chel+T

G Sireerr o _
ot
32 Sef KeyStore Password Ckrl+P
@ Change Keystore Tvpe 3
[5 Kevstore Report Chrl+R

B- Options

ICanigure KeywTool GUI's optionz

Typically the cacerts file can be found in <Java_Home>\jre\lib\security\

options x|

CA Certs KeyStore | Lok & Feel I

¥ U=ze ca Certs Heystore

CA Certs WeyStore: IC:'Ijava'lesdH A Hjrellibizecurityy Browese

Ok Cancel
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Appendix | — Secure Socket Layer (SSL) and Digital
Certificate

SSL is a commonly used protocol for managing the security of a message transmission on
the Internet. SSL contains its own server-side authentication and an optional client
authentication. SSL is a framework that specifies how two hosts connect, pass certificate
between one another, negotiate which keys to use, and decide on an encryption
mechanism.

SSL comes in two strengths, 40-bit and 128-bit, which refer to the length of the "session
key" generated by every encrypted transaction. The longer the key, the more difficult it is
to break the encryption code. Most browsers support 40-bit SSL sessions, and the latest
browsers enable users to encrypt transactions in 128-bit sessions - trillions of times
stronger than 40-bit sessions.

Encryption is performed in two ways: symmetric and asymmetric. In symmetric
cryptography, the sender and the receiver share the same private key to encrypt the
information that is sent between them. In asymmetric cryptography, the sender and the
receiver have different private keys. The length of a private key can range from 512bit to
2048bit. The larger a key length, the more difficult it is to derive the private key from the
public key, hence, making it more secure and less likely to be spoofed.

When HTTP is passed over the SSL infrastructure, HTTP can use all features of SSL.
This combination of HTTP and SSL is commonly used for secure Internet systems and it
is referred to as HTTPS.

SSL is normally used in tandem with a Digital Certificate. This means that it uses a third
party, a Certification Authority (CA), to identify one end or both ends of the transactions.
Digital certificates are electronic files used to uniquely identify people and resources over
the Internet. They contain information about the ownership of the certificate as well as
information about the issuing CA. SSL also provides a legal basis to perform transactions
on the Internet and is an integral part of the process for establishing the validity of digital
certificates.

Virtually all web servers and the leading browsers, including Internet Explorer and

Netscape Communicator, are optimized and ready for SSL. To activate SSL sessions a
digital certificate is required.
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Appendix Il — FAQs

Q1. What types of digital certificates does Grants.gov support?
Al. Grants.gov only supports certificates that use the RSA algorithm. It does not support
DSA certificates.

Q2. Where are the SSL URLs for the Grants.gov Web Services?

A2. The Acceptance Testing site where applicant system’s may conduct testing is located
at https://atws.grants.gov:446/. The production site is located at
https://ws.grants.gov:446/. Note that both sites require you to access them via port 446.

Q3. My organization is not ready to invest in a CA signed certificate; can we begin
testing with a self-signed certificate?

A3. You may use the self-signed certificate provided with the Reference Implementation
for testing in the Grants.gov Acceptance Testing environment. However, applicants
must purchase and test using a CA signed certificate before moving to production.

Q4. Typically, what should be the length of my private key?
A4. 1024 or 2048 bit is normally the recommend length

Q5. What is the difference between a keystore and a truststore?

AS. A keystore is the digital file that contains both your private and public key. A
truststore is a set of public CA root certificates that are used to validate the authenticity of
a CA signed server certificate.

Q6. Why does Grants.gov require a CA signed certificate?

A6. There are two reasons for doing this:

1) Grants.gov is only required to maintain the root CA certificates, rather than each
organization’s certificate.

2) A CA signed certificate is more secure and difficult to spoof than a self-signed
certificate.
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